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How do I print the Job results? 

1.  Select the Job toolbar button. 
2.  If the Job List is not displayed, click on the Job toolbar button again. Right 

click to select the Job to print from the Job List. 
3.  From the right click menu, choose the Print Job Results menu item. 
4.  If you have any asset that has been added to the job but does not have data 

associated with it a dialog will be displayed to determine if you want to print 
blank forms.  Select Yes if you want to print blank forms.  Note: for Jobs 
printed with blank results the Table of Contents and test results will not 
paginate. 

5.  The Print Results dialog will now be displayed.  To set up your desired print 
sort order, click the Edit Sort button.  To use one or more attributes, select the 
attribute(s) listed in the left and click the Add button. To remove sort 
attributes, select the attribute in the right list and click the Remove button. 
You may adjust the order of priority of selected attributes by selecting an 
attribute and clicking the Up and Down buttons. 

6.  If you wish to print the Table of Contents, Comments Summary and 
Deficiency Summary click each check box to select the report to print. 

7.  Click the Print button to print, or Cancel.  
 
 
 
 

How do I print an individual test form from a Job? 
1. Select the Job toolbar button. 
2. Select the Job from the Job List and double click to open the Job.  Select the 

test form from the tree and open the form.  Click on the form to enable the 
Print function. 

3. Click the Print toolbar button. Click OK to print or click Cancel. 
 
 

How do I print a group of test forms from a Job? 
1. Select the Job toolbar button. 
2. Select the Job from the Job List. 
3. From the right click menu, choose Print Job Results. 
4. You may sort the test forms to group together the desired results. Select the 

Only # radio button under the Print Range options.  Enter the number or 
numbers from the # column of the desired results. 

5. Click OK to print or click Cancel. 
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How do I move a softkey license? 
1. Click the Tools button on the toolbar, and then select PowerDB Licensing.  

Note:  If either machine does not have connection to the internet, follow the 
instructions provided in the License Information dialog box. 

2. In the License Information dialog box, make note of the serial number 
displayed at the top.  Click the Remove button. 

3. Type ‘remove’ in the edit box of the Remove PowerDB License dialog box 
and click OK. 

4. Start PowerDB on the new machine.  Click the Tools button on the toolbar, 
and then select PowerDB Licensing. 

5. In the License Information dialog box, enter the serial number and click the 
License Online button.   

 
 

How do I change the active database? 
1. Select File, then Change Database. 
2. Browse to the directory that contains the desired database. 
3. Double click on the database file.  It should now appear as the active database 

in the dialog box.  Click OK.  The system will prompt you that it will shut 
down, click OK. 

4. Restart PowerDB and Logon.  The active database directory is displayed in 
the status bar located at the bottom of the screen. 

 
 

How do I create a new User Account? 
1. Select View, then select User Accounts to display the current user accounts.  

The Administrator account is a built-in account and may not be removed.  
Note:  refer to the Users Manual for details on privilege levels. 

2. Click the New button on the toolbar. 
3. Complete the fields in the dialog box.  Click OK. 
 
 

How do I Spell Check a test form? 
1. To Spell Check the entire test form, deselect all controls by clicking in a 

blank portion of the form. Note:  the Spell Check feature is only available in 
the Job portion of PowerDB. 

2. Hit the F7 key or choose Check Spelling from the Forms menu.  
3. To Spell Check a single input field, click in the field, then hit the F7 key or 

choose Check Spelling from the Forms menu. 
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How do I edit an existing User Account? 
1. Select View, then select User Accounts to display the current user accounts.  

The Administrator account is a built-in account and may not be removed.  
Note:  refer to the Users Manual for details on privilege levels. 

2. Select the user account to be edited and double click to open the properties 
dialog box 

3. Make the appropriate changes.  Click OK. 
 
 

 
 

How do I set up a new Job? 
1. Select the Jobs toolbar button. 
2. While viewing the Job List, click the New toolbar button. 
3. The Job Properties dialog box will be visible.  Click the Edit Selection button. 
4. Select a customer from the list or add a new customer by clicking the Address 

Book button. 
5. Complete the required information in the Address Book and click OK.   
6. Select the address information under each tab of the Job Properties dialog 

box.  The Job Number and Temperature Correction Factor may be entered 
under the General tab of the Job Properties dialog box. 

7.  Click OK.  The new Job will appear in the Job List.  Double click on the Job 
to open the Job. 

 
 

How do I add records to my address book? 
1. Under the View menu, select Address Book. 
2. Click on the New button and enter the company name.  Click OK. 
3. Click on the New Address button.   
4. Select the type of address you want to set up in the Type dropdown box.  A 

Customer is who the asset is being test for.  The Customer name and address 
information as entered here will be used in the header of related test forms.  A 
User is who uses the asset being tested. The User name and address as entered 
here will be used in the header of related test forms. A Plant is the physical 
location of the asset to be tested.  The User and Plant information 
automatically populate the Job navigation tree.  

5. Fill in the address information fields and click the Save button.   
6. Repeat steps 3-5 for all addresses related to this company.  The drop-down 

box described as Type determines whether the information entered is stored 
as a Customer, User or Plant.  The drop-down box described as Show Types 
determines which addresses by type are displayed for editing.   
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How do I set up a new Job for a new customer? 
1. Select the Jobs toolbar button. 
2. If the Job List is not displayed click on the Job toolbar button again.   
3. Select the New toolbar button to display the Job Properties dialog. 
4. Select the Edit Selection button to select a Customer. 
5. Click on the Address Book button to add a new Customer. 
6. Enter the new Customer’s name. 
7. Click on the New Address button to add an address for the Customer. 
8. Select the type of address.  You will need a minimum of a Customer address.  

If you are a subcontractor for another testing company a User address also 
must be added. 

9. Complete the address information. 
10. Click the Save button. 
11. Click the OK button. 
12. Select the Customer you just added in the top portion of the Select Customer 

Address dialog. 
13. Select the address you just added in the bottom portion of the dialog. 
14. Click the OK button. 
15. If you are not a subcontractor on this job, click on the Copy to User button to 

set the User to the same values as the Customer. 
16. The dialog will now display the General tab.  PowerDB will automatically 

generate a Job Number.  If you would like to edit the Job Number type your 
information into the Job Number field. 

17.  Click the OK button.  The new Job will appear in the Job List.  Double click 
on the Job to open the Job. 

 
 

How do I add assets to a Job? 
1. Select the Jobs toolbar button. 
2. Double click on the job in the Job List.  The job information will appear in 

the navigation tree. 
3. Right click on the navigation tree and choose Add to Job, or click the Add To 

Job button.   
4. Select a Substation from the information displayed or enter a Substation in the 

edit box.  Click the Next button. 
5. Select a Position from the information displayed or enter a Position in the edit 

box.  Click the Next button. 
6. Select a Form Family from the list.  Click the Next button. 
7. Click on a form to add to the job.  You may select multiple forms by holding 

down the Ctrl key.  Click the Finish button.  The selected forms will then 
appear in the navigation tree. 
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How do I insert different folders for the same Job? 
1. Click the Jobs toolbar button. 
2. Select the job from the Job List to view the navigation tree.  
3. Click on a folder at a level above the level you wish to add, for example to 

add a new Substation folder click on a Plant level folder. 
4. Click the Add to Job toolbar button. 
5. You may click on existing information in the upper portion of the dialog box 

or add new information in the edit box in the lower portion of the dialog box.  
Click the Next button. 

6. Proceed through the Enter or Select dialog boxes by entering information and 
clicking the Next button, or click the Back button to return to higher level 
folders. 

7. Click the Finish button in the Select the Tests to Perform dialog box.  View 
your changes in the navigation tree for correctness.  

 
 

How do I move assets/results within a Job? 
1. Select the Jobs toolbar button. 
2. Double click on the job in the Job List.  The job information will appear in 

the navigation tree. 
3. While viewing the navigation tree for the job, click on the asset you want to 

move.  Right click and choose Move Asset.  Note: you may move entire 
folders as well by selecting the top folder in the tree. 

4. Proceed through the dialog boxes to select the desired new location for the 
asset. 

5. Click Finish, and view the navigation tree for correctness. 
 
 

How do I move assets/results to another Job? 
1. Select the Jobs toolbar button. 
2. Double click on the job in the Job List.  The job information will appear in 

the navigation tree. 
3. While viewing the navigation tree for the first job, click on the asset you want 

to move.  Right click and choose Move To Job.  The system will prompt you 
that the asset will be associated with another job.  Click OK to continue. 

4. Select the new job from the list and click OK. 
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How do I set up a Job for repeat testing? 
1. Select the Jobs toolbar button. 
2. If you are going to repeat the same test forms for the same assets, select the 

job results in the Job List, then choose Copy then Paste from the right click 
menu.  The asset from the old job will also be associated with the new job.  
Historical data for each asset can be viewed from the new job, but only data 
for the active job can be modified. 

3. The new job will be added to the Job List with the next available Job Number. 
You can edit the Job Number under the General tab in the Job Properties 
dialog box. 

 
 

How do I pre-populate nameplate data from another form? 
1. Select the Jobs toolbar button. 
2. Double click on the job in the Job List.  The job information will appear in 

the navigation tree. 
3. Open a test form where the desired nameplate information has been saved.  
4. While in the same job, open a new test form or add a new test form in the 

same form family.  The system will prompt you if you want to use the same 
nameplate information from the previous test. 

 
 

What is the difference between the Asset and Job view? 
The Asset view is an inventory listing of each asset in the database while the Job view 
contains only the assets for the selected job.  

1. Click on the Asset toolbar button to view the Asset navigation tree.  The tree 
is an inventory of each asset in the database.  Assets can be added to the 
database only by opening a Job and adding assets to the Job.  Assets can be 
deleted from the database in the Asset tree by choosing Delete from the right-
click menu.  Test results can be viewed from the Asset navigation tree but 
cannot be changed. 

2. Click on the Job toolbar button to view the Job List and to view a selected Job 
tree.  In the Job view you can add, move, remove, copy, paste or delete assets 
or test data from the right-click menu.  Test data may be entered, changed, 
Spell Checked and saved to the database in an active Job test form. 
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How do I send a technician into the field? 
1. Click the Jobs toolbar button. 
2. Click the File toolbar button, select New Database and then select New Field 

DB.  Select a location and enter a file name for the new field database to be 
created.  Click the Open button. 

3. The PowerDB Synchronization Status dialog box will be visible and will 
indicate when the process is complete.  Click the Finish button. 

4. In the Job List, click on a job you want to transfer to the new field database 
and choose Synchronize Data.  Verify that the primary and secondary 
databases displayed are correct.   

5. Select Job Transfer in the Operation dropdown box. 
6. If you want to transfer more than one job to the newly created field database, 

choose the Select Job(s) button in the Job Options.  Complete the criteria as to 
Include Options and Transfer Settings.  Click the Start Transfer button. 

7. Complete the PowerDB Synch - Secondary Login dialog box and click the 
OK button.  Click on the job(s) to be transferred.  To select multiple jobs, 
hold down the Shift key while clicking on the jobs to transfer.  Click the 
Select button.  The PowerDB Synchronization Status will display the transfer 
progress.  Click the Finish button when the process is completed. 

 
 
 

How do I get data from the field? 
1. Click the Jobs toolbar button. 
2. Click the Tools toolbar button and select Synchronize Data or choose 

Synchronize Data from the right click menu of a selected job in the Job List.  
This will open the PowerDB Database Utility dialog.  Note:  either the master 
or the field database may initiate the job information synchronization. 

3. Select a primary and a secondary database for the data transfer.  If the 
database is on a remote computer you may access the database by entering the 
IP address of the remote machine.  There is an option to backup each of the 
databases prior to the synchronization. 

4. Select Job Transfer in the Operation dropdown box. 
5. Choose the direction of information transfer from the Direction Options. 
6. Choose which test results to transfer from the Results Options. 
7. Complete the synchronization criteria as to Job Options, Include Options and 

Transfer Settings.  Click the Start Transfer button.  Information conflicts will 
be presented for resolution. 
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How do I get data from the field to a USB drive? 
1. You must create a database on the USB flash card from the master database. 

In the master database click the File toolbar button, select New Database and 
then select New Field DB.  Select the location to be the USB flash card and 
enter a file name for the new field database to be created.  Click the Open 
button. 

2. The PowerDB Synchronization Status dialog box will be visible and will 
indicate when the process is complete.  Click the Finish button. 

3. When you are ready to transfer data from your field (laptop) database to the 
USB flash card click the Jobs toolbar button. 

4. Click the Tools toolbar button and select Synchronize Data or choose 
Synchronize Data from the right click menu of a selected job in the Job List.  
This will open the PowerDB Database Utility dialog.  Note:  either the master 
or the field database may initiate the job information synchronization. 

5. Select a primary and a secondary database for the data transfer.  Set the 
primary database to be the laptop hard drive, select the secondary database to 
be the USB flash card. There is an option to backup each of the databases 
prior to the synchronization. 

6. Select Job Transfer in the Operation dropdown box. 
7. Choose the direction of information transfer from the Direction Options to be 

primary > secondary. 
8. Choose which test results to transfer from the Results Options, we 

recommend Most Recent. 
9. Complete the synchronization criteria as to Job Options, Include Options and 

Transfer Settings.  Click the Start Transfer button.  Information conflicts will 
be presented for resolution. 

 
 

How do I create a backup of my database? 
1. Click the File button on the toolbar and select Change Database to determine 

the path of your database file.  
2. Use Windows Explorer to locate your .mdb file.  Right click and choose 

Copy.  Paste your file in a different location or on an external device. 
 

How do I pre-populate default Comments and Deficiencies? 
1. In the SubForm Tree, open the User Data subform.  Place your cursor in the 

lower right portion of the small red box and double click.  This will open 
Form Properties. Click the Script button and select the Data tab. 

2. In the areas indicated enter your default Comments and Deficiencies exactly 
as you wish them to appear.  (i.e., comments will go on lines between 
“DefaultComments:” and “:END”, and deficiencies will go on lines between 
“DefaultDeficiencies:” and “:END”)  

3. Click OK, return to the Form Properties dialog box and click OK.  Save your 
changes. 
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How do I run an automated power factor test on a two-winding transformer using 
the Megger Delta 2000? 

1.  Click the Job button on the toolbar to display the Job View 
2.  Double click on the job that you would like to run the test on 
3.  Click the ‘Add to Job’ Tool Bar button 
4.  Enter or Select a Substation and then press the ‘Next’ button 
5.  Enter or Select a Position and then press the ‘Next’ button 
6.  Double click on the ‘POWER FACTOR TESTS’ entry in the list box 
7.  Double click on the ‘MEGGER’ entry in the list box 
8.  Double click on the ‘TWO WINDING TRANSFORMERS’ entry in the list 

box.  Respond ‘YES’ when prompted to open the form. 
9.  Click on the ‘Instrument Setup’ toolbar button.  Holding the mouse still over 

each toolbar generates a tool-tip with the toolbar button name. 
10.  Click on the ‘Model’ column of the ‘Power Factor Test Set’ row and then 

select ‘Megger – Delta 2000’ from the instrument drop down list 
11.  Select the gray button on the ‘Power Factor Test Set’ row in the ‘Setup’ 

column  
12.  Select the serial communications port that you wish to use.  The remaining 

communication parameters should be set as follows: 
Baud Rate = 9600, Data Bits = 8, Parity = None, Stop Bits = 1 

13.  Select the ‘OK’ button on the Serial Device Configuration dialog 
14.  Select the ‘Close’ button on the Instruments Setup dialog 
15.  Connect the ‘PC’ serial cable from the Delta 2000 to the PC 
16.  Press the ‘Init Test Set’ button located in the left margin of the form.  The 

button should change to ‘Instrument OK’ and the test numbers should turn 
blue. 

17.  Enter the nameplate information and the temperature.  The nameplate 
information is used to determine the temperature correction factors.  Note that 
some combinations of nameplate information do not represent valid 
transformers and a message box will inform you if this is the case.  Correct 
the nameplate information; if the information is still unknown enter 
temperature correction factors manually. 
Note that KVA label can be changed to MVA by clicking on it and selecting 
MVA.  A temperature entry is required to refresh the temperature correction 
factors. 

18.  Enter the bushing nameplate information.  Note that the bushing temperature 
correction factors are based on the bushing type/class and the air temperature. 

19.  Right click on TEST NO 1 
20.  Follow the instructions on the dialog.  Note that the dialog instructs you on 

the required grounding and guarding and to press the ‘Record’ button on the 
Delta 2000 prior to selecting the ‘OK’ button. 

21.  The data for TEST NO 1 should be filled in. 
22.  Repeat steps 19 and 20 for TEST NOs 2 through 19  
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